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1. Introduction 
The Environmental Security Technology Certification Program (ESTCP) and Strategic 
Environmental Research and Development Program (SERDP) have funded the 
development and implementation of statistical site characterization protocols for sites 
potentially contaminated with unexploded ordnance (UXO).  These site characterization 
protocols are focused on the identification and delineation of potential target areas 
occurring at a site using limited amounts of geophysical transect data.  Developments 
over the past several years include approaches for transect design, target identification 
and boundary delineation, and geophysical anomaly density mapping. 
 
These design and analysis tools have been implemented in the Visual Sample Plan (VSP) 
software.  VSP is a statistics-based environmental and threat contamination sampling 
software tool with an easy-to-use visual interface that provides users who are not experts 
in the field of statistics the ability to obtain a specified amount of data quality based on 
the required objectives for the site (commonly called data quality objectives [DQO]).   
For a more detailed description of the additional sampling designs and functionality of 
VSP see Matzke (2007).  This free software can be downloaded from the VSP website at 
http://dqo.pnl.gov.   
 
This report summarizes the basis for and implementation of the analyses in VSP to meet 
four sampling goals considered to be priorities during characterization of a potential 
UXO site.  These four goals are 1) transect design to ensure that target areas of concern 
are identified with a prescribed confidence level, 2) flagging of potential target areas 
along the transects obtained at the site, 3) mapping of the estimated anomaly density at all 
locations across the site based on the transect data and the model of spatial variation 
derived from those data, and 4) delineation of the target boundary from the anomaly 
density maps.  These four sampling and analysis goals are attained within VSP using the 
dialogues found under “Sampling Goals > Find UXO Target Areas” as shown in 
Figure 1.  These goals and the mechanics of achieving them in VSP are discussed in this 
report.  In addition to these four priority goals, a fifth goal of assessing the probability of 
traversing a target area after the data collection is complete is also discussed in this 
report.  The different topics and the report sections in which they are discussed are listed 
below:  
 
• Transect spacing needed to locate a UXO target area (Section 2) 

 
• Locating and marking UXO target areas intersected by transects based on elevated 

anomaly density (Section 3) 
 

• Geostatistical mapping of anomaly density across site area (Section 4) 
 

• Delineation of target area boundaries (Section 5) 
 

• Assessing probability of target area traversal based on actual transect pattern  
(Section 6). 
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Figure 1.  Image of VSP “Sampling Goals” menu structure and the sub-menu for “Find UXO Target 
Areas.” 

2. Transect Design Approach   
VSP provides the user with two methods for creating a transect design to meet desired 
DQOs.  The ”Traversal” design (see Section 2.5) can demonstrate a specified probability 
that at least one transect will traverse a target area of a specified size and shape.  The 
other design, “Traversal and Detection” (see Section 2.6) demonstrates a specified 
probability that a target area of a defined shape, size, and density will be traversed and 
detected with a specific transect design and assumed background density.  In addition to 
these two methods, the user can manually place transects within a sample area- the 
“Manual” method (see Section 2.7).  All three of these methods are contained within the 
“Transect spacing needed to locate a UXO target area” dialog.   
 
Table 1 lists the variables that can be adjusted in this dialog and identifies which transect 
design method uses the variable.  The three different methods are identified as Traversal, 
Traversal and Detection, and Manual in this table.  The “additional information” column 
provides general information about the variable.  Each of these variables will be 
described in more detail in the following sections.  The first four variables listed in the 
table (Transect Pattern, Transect Width, Target Area Shape, Target Area Orientation) are 
generally defined by the survey equipment and the specific site use.  The design objective 
selected will determine the importance of the remaining variables.  The design objectives 
are specifically stated in VSP as “Ensure High Probability of Traversal Only” 
(Traversal), “Ensure High Probability of Traversal and Detection” (traversal and 
detection), and “Manual Transect Spacing” (manual). 
 
Of the three transect design methods, the traversal and detection design objective 
provides the most valuable information about the specific transect design selected.  
However, as Table 1 shows, it requires knowledge and input for many more variables 
than the other two.  The traversal design guarantees that the assumed target area will have 
a specified probability of being traversed but falls short of any estimate that the target 
area will actually be identified. 
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Table 1.   Variables that can be adjusted in the “Transect spacing needed to locate a UXO target area” 
design dialog with selected additional information about the variable and if the variable is used in one of 
the three transect design methods. 
 

Variable Additional Information Traversal 
Traversal and 

Detection Manual 

Transect Pattern 
Select from Parallel, Square, Rectangular 
designs x x x 

Transect Width Enter value in meters, feet, or inches x x x 

Target Area Shape select from area, length of axes, shape x x   
Target Area 
Orientation select random or enter known degrees x x   

Required Probability 
of Traversing Target Enter value between 50 and 100. x     

Transect Spacing 
Enter value in units defined by the map in 
use.     x 

Starting location 
Select from random or fixed X,Y location 
on the map     x 

Background Density 
Enter value in acres, hectares, or square 
feet, meters, inches, kilometers, or miles   x   

Background Decision 
Rule 

Stated in terms of percent confident 
density > bkg   x   

Instrument False 
Negative Rate Enter any value between 50 and 99.99   x   

Proposed Evaluation 
Transect Spacing 

Input the minimum and maximum 
transect spacing in the same units as the 
map.   x   

Target Area density 
(above background) 
range 

Input the minimum and maximum density 
in the same units as background density   x   

Target Area density 
above background 

Enter value in same units as background 
density.   x   

Target Area Density 
Distribution Uniform or bivariate normal   x   

Density Input  

Only used for the bivariate normal target 
area density distribution.  Select outer 
edge, center, or average of the target area.   x   

Minimum Precision A proportion between 0.05 and 0.20   x   

Maximum Error A proportion between 0.005 and 0.10.   x   
Search Window 
diameter 

Enter value in units defined by the map in 
use.   x   
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2.1. Building the Conceptual Site Model 
 
A conceptual site model (CSM) is a basic description of how the site was used and the 
possible contaminants which could be in the system.  The CSM identifies essential 
information about the site and provides an essential framework for assessing risks from 
contaminants.  Often the most difficult part, or at least the most important part, of the 
final transect design for a specific site is reaching consensus on the size, shape, and 
overall density of the target area of interest.  Often, this information can be obtained from 
archive search reports (ASR), previous Conceptual Site Models (CSM’s), other previous 
studies, current imagery (i.e., lidar, orthophotography), and site experts.  Even with all of 
this information, there still can be uncertainties about proper design assumptions.   
 
As with any environmental work, it is important that all interested parties agree to the 
assumptions of the current CSM.  Even when information necessary to make the “best” 
decision is missing, there is often enough information to make a conservative decision to 
which all parties can agree. 

2.2. Map design and data import 
 
The user can import previously made DXF or SHP files to create the appropriate sample 
areas or use the tools within VSP to manually draw sample areas.  In addition to creating 
interactive sample areas, background images can be imported into VSP.  Figure 2 
provides an example of a VSP project with a background image behind the defined 
sample area.  The VSP user’s manual contains a more detailed description of how to use 
these and all the other map design tools (Matzke, 2007).  
 
Load map from file 
 
Figure 3 shows the VSP dialog obtained by following the menu structure “Map > Load 
Map from File.”  This is the method used to open any SHP or DXF file in VSP.  VSP 
will open a SHP file without the associated DBF, SHX, AUX, or PRJ files.  If there is an 
associated PRJ file then VSP will automatically load the units for the opened SHP file.  If 
the PRJ file is missing, the “Map Settings” dialog (Figure 4), found under “Map > Map 
Settings,” allows the user to manually set the map units.   
 
Background picture 
 
Through the menu structure “Map > Background Picture > Load from File,” a JPG 
image file can be loaded.  After an image is loaded into a VSP project, users can 
manually georeference the image by using “Calibrate with Map” and following the 
instructions shown Figure 4. If the loaded JPG file has an associated world file (JGW), 
selecting “Map > Background Picture > Load World File” from the menu structure 
will allow the selection of the matching world file and automatically georeference the 
previously loaded image file. 
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Figure 2  Example of a background image used with a VSP project.  This is the Victorville, California site 
discussed in Sections 3.2.2 and 3.2.3. 
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Figure 3. Menu to import SHP or DXF files.   Found from the drop down menu “Map > Load Map from 
File.” 
 

  
 
Figure 4.  Map Settings dialog to manually alter the map in the current VSP project (left).  Calibrate 
Background Picture dialog used in VSP to georeference a loaded JPG file (right). 
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2.3. Target Area Size, Shape, and Orientation 
 
Before using many of the tools available with the transect design dialog the user must 
gather the current information from the CSM to identify the size, shape, and orientation 
of the target area of interest.  Typically the information in the current CSM does not 
include the specific size, shape, and orientation to be used so that must be derived from 
the munition-use information provided.  Currently, the typical information includes the 
different munitions used on the site, the number of years the site was used, and direction 
from which the munitions were fired.  This information used in combination with 
information from munition-firing tables can be used to calculate the final size, shape, and 
orientation of the target area of interest.  These tables are explained in various manuals 
and technical documents.  Field Manuals 6-40 (U.S. Army 1996) and 7-90 (U.S. Army 
1992) are two military manuals that contain information and examples used to create the 
information shown in Figure 5.   
 
The Target Sizing Modeling Methods project funded by ESTCP (MM-0507) is 
developing functionality to allow a user to specify the munition of interest along with 
other input information to identify the size, shape, and orientation of target areas that 
result from indirect fire weapons.  It is anticipated that the target sizing tools developed in 
that project will be integrated into VSP in the future.   
 
The following discussion details how the target area is currently derived for use in VSP 
from the information in Field Manuals 6-40 (U.S. Army 1996) and 7-90 (U.S. Army 
1992).  These manuals detail how the shells from a single gun will tend to deviate around 
the specific target (dispersion rectangle) as well as the distance fragments will travel from 
the point of impact for each of the shells (fragmentation range).  Figure 5 shows how 
these two inputs are used to derive the final target area size and shape. 
 
Fragmentation range radius  
 
Figure 5 shows the assumed fragmentation range of a single exploded munition as the 
pink circle in the upper right.  For any specific munition, the fragmentation range 
estimates can vary quite a bit.  Some tables report small radii values that identify the 
range at which lethal damage would occur while other tables report the much larger radii 
values based on the maximum distance fragments could fall from the impact point .  The 
optimal fragmentation range radius will fall between these values and requires agreement 
among all involved in the site characterization effort.  
 
Dispersion rectangle and probable errors 
 
The center of the dispersion rectangle (green box of grids shown in the upper left of 
Figure 5) is the specific target at which the munitions are fired.  The points of impact of 
the projectiles will be scattered both in deflection and in range.  Dispersion is caused by 
inherent (systemic) errors. It should never be confused with round-to-round variations 
caused by either human or constant errors.  This rectangular shape of the box represents 
the two types of probable errors:  1) range probable error and 2) deflection probable error.  
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From the definition of probable error, 50 percent of all rounds will impact within one 
probable error in range or deflection of the mean point of impact (25 percent over and 25 
percent short or 25 percent left and 25 percent right), the grids in this dispersion rectangle 
are derived.  Moving out four probable errors (the entire box of grids) will contain all the 
impact points when the munitions are fired at the target.  For a more detailed discussion 
of range and deflection probable error see Field Manual 6-40 (U.S. Army 1996).   
 
Target area size and shape 
 
The final target area size and shape represents the merging of this information as the 
bottom ellipse shows in Figure 5.  This figure provides an example of one possible 
munition.  Often, the fragment dispersion radius is the primary driver of the final target 
area size as it is usually much larger than the impact zone.  Conservative estimates of the 
final target area are usually circular with the radius of the circle resulting from the semi-
minor axis of the ellipse derived from the process shown in Figure 5. 
 

 
  
Figure 5.  Diagram of the process of identifying the target area size and shape for a specific munition. 
 
Survey and target area pattern tab 
 
The “Survey & Target Area Pattern” tab from the “Transect spacing needed to locate a 
UXO target area” dialog, shown in Figure 6, lets the user input the target area 
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information in a few different methods.  The user must identify the total area of the target 
area or the length of the semi-major axis and either the length of the semi-minor axis or 
the shape of the oval.  As Figure 6 shows, two of the options (“Area of Target Area” and 
“Length of Semi-Minor Axis”), which are not selected, cannot be manipulated; however, 
VSP does report the actual values based on the other two selected values (“Length of 
Semi-Major Axis” and “Shape”). 
 

 
 
Figure 6.  The “Survey & Target Area Pattern” tab located within the “Transect spacing needed to locate a 
UXO target area” design dialog. 
 
Target area orientation 
 
When the identified target area is not a circle, the angle of orientation between the target 
area major axis and the transect orientation on the map can be defined or marked as 
random in the “Angle between Major Axis and Transects” box.  The orientation of the 
target area is derived from knowing the target location and the direction from which the 
target was fired upon.  The random option is selected when the orientation of firing point 
to target area is unknown.  The orientation of the surveyed transects to target areas, which 
have a strong elliptical shape, can have a significant impact on the final transect design.  
This relationship is discussed further in the next section. 
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2.4. Selecting a Transect Pattern, Width, and Orientation 
 
Figure 6 also shows the “Transect Pattern” options box that can be selected and the input 
where the transect width can be entered.  Transects can follow a parallel, square, or 
rectangular pattern.  As these options are selected, the dialog shows an image of the 
transect pattern next to the transect inputs.  
 
Transect pattern 
 
Typically, the parallel transect pattern has been preferred for circular target areas, but the 
square and rectangular transect patterns may be desired for different types of elliptical 
target areas.  If the CSM does not identify a specific transect pattern, then any of the three 
patterns can be selected and evaluated for performance.  Practical, site-specific 
considerations of transect collection will also impact the transect pattern selection. 
 
Transect width 
 
The transect width can be entered in the units of feet, meters, or inches and can be any 
value chosen by the user.  The transect width is a function of the footprint of the 
equipment being used on the site and is usually set to the width of the equipment 
footprint.   
 
Transect orientation 
 
By selecting “Edit > Sample Areas > Set Grid Angle,” the orientation of transects on 
the map can be changed.  After this option is selected, the user must click on the map and 
draw a straight line representing the transects orientation on the site. 
 
The orientation of transects is an important input if the target area is elliptical and the 
orientation of the major axis of the target area is known.  The final impact of knowing the 
orientation of the target area with respect to the transects is dependent on many other 
inputs and should be evaluated in relationship to the finalized inputs selected for a 
specific design. 

2.5. Ensure High Probability of Traversal Transect Design 
 
The “Required Probability of Traversing Target” variable is the only probabilistic input 
required to obtain a specified transect design if the “Ensure high probability of traversal 
only” design objective is selected on the “Transect Spacing” tab (see Figure 7).  The red 
text shown in Figure 7 summarizes the resulting transect spacing based on the inputs.  
This text used the information from Figure 6 and Figure 7 and says, “If 1-meter-wide 
transects with a parallel pattern are spaced 60.96 m between transects (61.96 m on 
centers) over the entire site, these transects will traverse any 200-ft-diameter (60.96 m) 
circular target area 100 percent of the time.”  For a more technical explanation of how 
these calculations are performed see Gilbert (2001).  
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If the only objective of the transect design is to ensure a high probability of traversal the 
required probability entered is usually 100 percent.  Other values as low as 50 percent can 
be entered if desired by the user.  The specified transect spacing will be applied to the 
entire map if the “OK” or “Apply” buttons are pressed.  In addition, a summary of the 
transect design and the associated inputs will be created in the report view of VSP (see 
Section 2.8).  
 
If traversal is the only design objective and an elliptical target area with a known 
orientation is assumed, then orienting the transects to be perpendicular to the semi-major 
axis will require fewer transects over the site.  
 
The “target detection performance” information box which falls below the DQO design 
statement in Figure 7 is not required for this design objective.  This information is there 
to provide the user with the ability to evaluate detection performance with different 
inputs based on the selected transect spacing.  The details of the “Target Detection 
Performance” box are explained in Section 2.6. 
 

 
 
Figure 7.  “Transect Spacing” tab view when the design objective “Ensure high probability of traversal 
only” is selected. 
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2.6. Developing a Probability of Detection and Traversal 
Transect Design 

 
The “Transect Spacing” tab when the design objective is “Ensure high probability of 
traversal and detection” is shown in Figure 8 (and subsequently in Figure 13).  This 
design uses a Monte-Carlo simulation to identify the appropriate transect spacing and 
associated probability of detecting a specified target area.  This design requires the user 
to identify more specific DQOs and provide more information about the conditions of the 
study area to be surveyed.  Table 2 lists all of these associated variables and how they 
impact the simulation running time and the results which come from the simulation.  
Each variable has a recommended value and some additional information for improved 
understanding.  For more detailed information about the variables and the simulation 
process see (Matzke 2006).   
 
Figure 8 shows the design objective “Ensure high probability of traversal and detection” 
with the probability of detection selected to be a function of the transect spacing.  When 
this option is selected, the final transect spacing is interactively selected from the target 
detection performance graph, and the resulting red text shown in Figure 8 summarizes the 
selected design objective based on the simulation parameters entered.  These graphs 
represent the data from the Monte-Carlo simulation.  The simulation then begins, and the 
graphs are created when the “Create Graph” button, shown in Figure 8, is pressed.  The 
“Additional Parameters” dialog in Figure 8 automatically opens when the “Create Graph” 
or “Graph Options” buttons are selected.  The “Additional Parameters” dialog provides 
the ability to adjust the remaining variables from Table 2 that are not shown in the 
“Transect Spacing” tab. 
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Figure 8.  “Transect Spacing” tab when the “Ensure high probability of traversal and detection” design 
objective is selected and the “Transect spacing evaluation range” is selected. 
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Table 2.  Variables which are used with the probability of traversal and detection design simulation.  The 
variables are listed along with additional information about how these variables affect the running time of 
the simulation and the results obtained from the simulation.  
 

Variable 
Input Values and 

Options 
Recommended 

Values 

Effects on 
Simulation 

Running time

Effects on 
Transect Design 

and Probability of 
Detections Additional Notes

Background 
Density 

Enter value in 
units per acre, 
hectare, or square 
feet, meters, 
inches, kilometers, 
or miles. 

The 
background 
density 
expected on the 
site.  This can 
often be 
estimated by 
initial 
geophysical 
transects 
conducted in 
areas with no 
prior munitions 
use. 

Large 
background 
densities 
increase the 
simulation 
time and small 
background 
values 
decrease it. 

The larger the 
background density 
the harder it is to 
identify any target 
areas. 

The background 
density and Target 
Area density above 
background 
variables are 
dependent on each 
other for a specific 
transect spacing.  In 
many scenarios the 
ratio of Target Area
density to 
Background density 
is important to keep 
in mind. 

Background 
Decision Rule 

Stated in terms of 
percent confident 
that density > bkg.  
Enter any value 
between 50 and 
99.99. 

More than 
 95 percent. 

Higher 
background 
decision rule 
values require 
longer run 
times. 

As the background 
decision rule moves 
from 99.99 percent 
to 50 percent, the 
specific transect 
design will have a 
higher probability 
of detecting the 
target area, but a lot 
of these detections 
may just be a result 
of finding an 
unusually high 
background 
density. 

The value that will 
require the tightest 
transect spacing 
(conservative) with 
all the other 
variables remaining 
constant is 99.99 
percent. 

Instrument 
False Negative 
Rate 

Enter any value 
between 50 and 
99.99. 

0 Generally, no 
effect on the 
simulation 
process. 

The larger the false 
negative rate, the 
harder it is to 
identify any target 
areas. 

The false negative 
rate is used in the 
simulation to 
quantify how well 
anomalies are 
found.  A value of 
10 percent would 
remove 10 percent 
of the anomalies 
from each 
simulated site 
before the window 
calculations are 
performed. 
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Variable 
Input Values and 

Options 
Recommended 

Values 

Effects on 
Simulation 

Running time

Effects on 
Transect Design 

and Probability of 
Detections Additional Notes

Target area 
density (above 
background) 
range 

Input the minimum 
and maximum 
density in the same 
units as back-
ground density. 

The target area 
densities 
expected on the 
site. 

Generally, a 
wider range 
increases the 
simulation 
time and a 
smaller range 
decreases it. 

No effect on the 
transect design. 

The simulation 
procedure uses the 
minimum and 
maximum values 
entered.  The 
number of other 
simulated target 
area density values 
along the curve 
varies for each 
range. 

Proposed 
Evaluation 
Transect 
Spacing 

Input the minimum 
and maximum 
transect spacing in 
the same units as 
the map. 

Varies, no less 
than 0.25 or 
greater than 
1.25 of the 
target area 
diameter. 

Generally, a 
wider range 
increases the 
simulation 
time and a 
smaller range 
decreases it. 

No effect on the 
transect design. 

The simulation 
procedure uses the 
minimum and 
maximum values 
entered.  The 
number of other 
simulated transect 
spacing values 
along the curve 
varies for each 
range. 

Target Area 
Density Above 
Background 

Enter value in 
same units as 
background 
density. 

The expected 
density of the 
target area of 
interest. 

The effect 
varies depend-
ing on the 
combination 
of the other 
variables. 

Higher densities are 
easier to detect with 
any given transect 
spacing and 
background 
density. 

Make sure the 
appropriate target 
area density 
distribution is 
selected for the 
value input.  In 
many scenarios the 
ratio of target area 
density to back-
ground density is 
important to keep 
in mind. 

Target Area 
Density 
Distribution 

Uniform or 
bivariate normal 

Bivariate 
normal 

The effect 
varies depend-
ing on the 
combination  
of the other 
variables.  
Generally, the 
choice of the 
uniform dis-
tribution runs 
faster than 
selecting the 
bivariate 
normal 
distribution. 

This interacts 
heavily with the 
transect spacing.  
The bivariate 
normal density 
target areas are 
detected more 
easily when the 
transect spacing is 
tight (transects have 
a higher chance of 
traversing the high 
density center).  
But in general, 
Uniform density 
target areas are 
easier to find. 

Generally, the 
default value of 
using the bivariate 
normal distribution 
is the proper 
choice.  
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Variable 
Input Values and 

Options 
Recommended 

Values 

Effects on 
Simulation 

Running time

Effects on 
Transect Design 

and Probability of 
Detections Additional Notes

Density Input  Only used for the 
“Bivariate Normal 
Target Area 
Density 
Distribution” 
option.  Select 
outer edge, center, 
or average of the 
target area. 

Any choice is 
valid. 

No effect on 
the simulation 
process. 

No effect on the 
transect design. 

Any of the three 
can be selected, but 
the target area 
density (above 
background) values 
should change as 
different inputs are 
selected. 

Minimum 
Precision 

A proportion 
between 0.01 and 
0.20 

Default value A small 
minimum 
precision 
increases the 
simulation 
time while a 
large 
minimum 
precision 
decreases it.  

A smaller minimum 
precision will 
simulate more 
points on the graph, 
and give more 
information on 
which to make a 
decision. 

Increasing the 
minimum precision 
simulates fewer 
unique range 
values. 

Maximum 
Error 

A proportion 
between 0.005 and 
0.1. 

Default value A small 
maximum 
error increases 
the simulation 
time while a 
large maxi-
mum error 
decreases it.   

A smaller 
maximum error will 
increase the 
accuracy of points 
on the graph, and 
allow for better 
decisions. 

A smaller 
maximum error 
requires more 
Monte-Carlo 
iterations at the 
specified range 
value. 

Search 
Window 
diameter 

Enter value in 
units defined by 
the map in use. 

Default value A larger 
window size 
typically 
makes the 
simulation 
faster. 

See Section 3.2.1. The default value is 
almost always the 
appropriate choice.
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Figure 9.  Additional simulation parameters that appears when “Graph Options” is selected from the 
“Graph Target Area Density vs. Probability of Detection” box. 
 
Transect target detection performance graphs 
 
Figures 10 and 11 show two transect target detection performance graphs.  These graphs 
show the probability of detecting a 200-m-diameter target area with 2-m-wide transects.  
The graph in Figure 10 was produced assuming the target area anomalies are uniformly 
distributed, while the graph in Figure 11 was produced assuming the target area 
anomalies follow a bivariate normal distribution.  Both graphs used all the default values 
from Table 2, 95 percent for the background decision rule, parallel transects, and  
10 anomalies per acre (ApA) for the background density.  Three different assumed target 
area densities are represented by the different color lines as labeled in the graphs.  The 
red curve represents the target area (TA) density which was selected in the design 
dialogue.  The other two curves are provided to show the sensitivity of the transect 
spacing based on different TA densities.  Generally, the default option to model the 
bivariate normal distribution for the Target area densities is the most realistic choice (see 
Table 2 for additional information).  
 
The vertical yellow line outlined in black in Figure 10 identifies the transect spacing 
which is equal to the size of the target area. As the transect spacing extends beyond the 
size of the target area the transect detection performance is heavily impacted by the 
reduction in the chances that the transects will even traverse the specified target area.    
 
The probability of detection values shown in these graphs identify how often at least one 
region within a target area will have an average density significantly greater than the 
background density.  Currently, the “false positive” detection performance (probability of 
identifying a target area that doesn’t actually exist) cannot be controlled by the user 
during the design process.  The “false positive” detections can be managed during an 
actual analysis of the surveyed data (see Sections 3 through 5) by the use of the spatial 
clustering of high density areas to distinguish between “false positive” detections and 
actual high density areas on the site.    
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Figure 10.  Target detection performance graph to detect a 200-m-diameter target area with 2-m-wide 
transects.  This simulation used all the default values from Table 2, 95 percent for the background decision 
rule, parallel transects, 10 ApA for the background density, and a uniform target density.  Three different 
assumed target area densities are represented by the different color lines as labeled in the graph. 
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Figure 11.  Target detection performance graph to detect a 200-m-diameter target area with 2-m-wide 
transects.  This simulation used all the default values from Table 2, 95 percent for the background decision 
rule, parallel transects, 10 ApA for the background density, and a bivariate normal target density.  Three 
different assumed average target area densities are represented by the different color lines as labeled in the 
graph. 
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Density target detection performance graphs 
 
Figure 12 shows a density target detection performance graph when the probability of 
detection is a function of the target area density.  The “Transect Spacing” tab associated 
with this target detection performance graph is shown in Figure 13.  The transect spacing 
is an input that can be altered by the user, but defaults to the selected transect spacing 
from the previously run transect target detection performance graph.  The density target 
detection performance graphs provide an improved understanding of the sensitivity of the 
selected transect spacing as a function of the TA density and allows the user to modify 
the specific data quality objectives stated in the dialog (see red text in Figure 8) based on 
this improved understanding.   
 
These target detection performance graphs identify the performance of different transect 
spacing options and provide the ability to select an appropriate spacing based on the 
defined DQOs.   Besides showing the performance of a particular design using a defined 
set of values for the variables in Table 2, the target detection performance graphs provide 
an efficient method to evaluate the sensitivity of different transect spacing options as 
compared to varied target area densities. 
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Figure 12.  Target detection performance graph to detect a 200-m-diameter target area with 2-m-wide 
transects.  This simulation used all the default values from Table 2, 95 percent for the background decision 
rule, parallel transects, 10 ApA for the background density, and a uniform target area density.  Three 
different transect spacing options are represented by the different color lines as labeled in the graph. 
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Figure 13.  “Transect Spacing” tab when the “Ensure high probability of traversal and detection” design 
objective is selected and the “Target area density (above background) range” is selected. 

2.7. Manual Transect Design  
 
As the term “manual transect spacing” implies in the design objective shown in Figure 
14, this design does not rely on any statistical support for the transect design.  This tool is 
in VSP to provide the user with the ability to use all the other features of this transect 
design module.  The user must enter the desired transect spacing and choose if the first 
transect must pass through a specific X, Y coordinate or be randomly placed on the map.  
Typically, this option is used to augment an already existing transect design.  As with the 
traversal only design objective, when this option is selected the “Target Detection 
Performance” information box is not necessary to create the specified design on the map.  
As was explained in Section 2.6, the “Target Detection Performance” information box 
does provide the user with the ability to evaluate detection performance with different 
inputs based on the selected transect spacing.   
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Figure 14.  “Transect Spacing” tab when “Manual transect spacing” is selected as the design objective. 
 

2.8. Using Transect Design Information in Reports and External 
Software 

 
After a user has created and finalized a site transect design, the information within the 
VSP project file can be exported for use in external software or for use in reports.  By 
selecting “Map > Export > to SHP” from the VSP menus and using the export dialog 
shown in Figure 15, all the map information shown on the map in Figure 16 can be 
exported using the ArcGIS SHP format.  All the necessary files to use these SHP files 
with external GIS software are included when the SHP file is created.   
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Figure 15.  Export to SHP dialog found within VSP when the UXO dialogs have been used.  This figure 
shows all the different information that can be exported for any of the UXO designs.  VSP will open with 
marked boxes where information is present. 
 
 

 
 
Figure 16.  Quad view in VSP of the four primary views to display data from a specific VSP project file. 
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Figure 16 shows the four views VSP provides for a specific transect design project file.  
The upper left corner has a map of the site with transects based on a selected design.  
This specific map has three unique areas within one site.  The munition use in each area 
was different and required unique designs.  The lower left shows the report view that 
summarizes the variable settings used to create the most recent transect design and the 
statistical assumptions and algorithms used to create these designs.  The graph in the 
upper right stores the most recent target detection performance graph generated from the 
“Transect spacing needed to locate a UXO target area” dialog.  The lower right window 
summarizes the information of the specific transect locations on the site.  The beginning 
and end points for each transect are listed with a summary of the width and length.   

3. Target Area Identification Approach 
 
Once a transect design has been accepted and the geophysical survey completed, the 
surveyed data (i.e., the transect course-over-ground and anomaly location data) is 
imported into VSP and analyzed.  Section 3.1 details how these data can be imported and 
manipulated in VSP.  Section 3.2 describes the methods used to evaluate the anomaly 
density distribution of the site and determine an appropriate critical density to identify 
high density areas within it.  The information from this target area identification analysis 
in VSP can also be exported for use in reports or other software (see Section 7 for a 
detailed explanation). 

3.1. Importing Course-Over-Ground and Anomaly Files into VSP 
 
The data entry tab shown in Figure 17 provides the ability to import ASCII (plain text) 
files identifying the course over ground (COG) and anomalies (anomaly) data.  Table 3 
shows an example of the COG file (left) and anomaly file (right) structure used within 
VSP.      Oasis Montaj can be used to generate COG and anomaly files like those shown 
in Table 3 (Geosoft, 2007).  VSP can also import the COG and anomaly information if 
they are saved in common TXT and CSV formats.  The two files shown in Table 3 show 
the most information that can be included in the file.  At a minimum, the file to be 
imported must have two columns representing the X and Y coordinates in that order.  The 
COG coordinates mark the X, Y location for the center of the survey equipment path.  As 
the file does not provide transect width information, the user must obtain it from the 
survey team.  The anomaly coordinates are locations where the survey team has identified 
an object of possible metallic origin.      
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Table 3.  Example of ASCII files that can be imported into VSP for the course over ground transect data 
and the associated anomaly location data. 
 

Example of COG file Example of anomaly file 
/ ----------------------------------------- / ------------------------------------------ 
/ CSV EXPORT [06/22/2007] / CSV EXPORT [06/22/2007] 
/ DATABASE   [.\07172015.gdb] / DATABASE   [.\07172015_anomaly.gdb] 
/ ---------------------------------------- / --------------------------------------------------- 
/ / 
/X,Y,GPS_Time /Fiducial,X,Y,Grid_value 
//Flight 0 //Flight 0 
//Date 2007/06/21 //Date 2007/06/22 
Random  GGK Random  07172015_Targets 
643636.04,4335445.66,76968.5 0,643685.125,4335486.500,40.21 
643638.10,4335446.86,76970.5 1,643803.250,4335587.000,84.87 
643641.17,4335449.01,76972.5 2,643907.750,4335681.125,45.61 
643643.34,4335451.14,76974.5 3,643918.875,4335707.000,1119.21 
643645.11,4335453.27,76976.5 4,643948.250,4335742.875,83.94 
643646.96,4335455.55,76978.5 

 

643648.91,4335457.71,76980.5 
643650.77,4335459.62,76982.5 
643652.71,4335461.39,76984.5 
643654.58,4335463.04,76986.5 
643656.47,4335464.60,76988.5 
643658.61,4335466.29,76990.5 
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Data entry tab 
 
The data entry dialog in VSP provides the user with the ability to import and identify all 
the necessary files for analysis.  Figure 17 shows this “Data Entry” tab that is included in 
the “Locate and mark UXO target areas based on elevated anomaly density” and 
“Geostatistical mapping of anomaly density” dialogs.  The tab provides import, export, 
removal, and file summaries for the COG and anomaly files in two separate boxes.  
When importing COG information, the user is prompted to define the width of the 
transects in the file before it is imported.  VSP provides a summary that includes the file 
name, number of lines imported, width of the transects, and the units associated with the 
transect width.  The anomaly data is imported and summarized in a similar manner.  The 
“Sel” column shown in each box provides a method to manipulate individual files.  If the 
box is blank, the file is not selected.  When the user enters a “T,” then the identified files 
can be removed or exported from the project.  If the box is marked next to “Mark points 
that are outside Sample Areas,” then any points in an imported file that fall outside of the 
selected sample areas are shown as red lines.  This feature helps the user identify 
locations where the survey went beyond the identified sample boundaries.     
 

 
 
Figure 17.  Data entry tab found within the “Find UXO target areas” dialog and “Geostatistical mapping of 
anomaly density” dialog. 
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3.2.  Locating and Marking UXO Target Areas Based on 
Elevated Anomaly Density  

 
After the sample area has been identified and the necessary files have been imported into 
VSP, the user can analyze the data.  VSP provides two dialogs for analyzing the spatial 
data.  This section details the dialog “Locate and Mark UXO Target Areas Based on 
Elevated Transect Anomaly Density” which identifies those locations within the transects 
that are identified as being high density (i.e., high number of anomalies within a specified 
amount of the surveyed transect area).     

3.2.1. Selecting a Smoothing Window for Analysis 
 
To identify high density areas along transects, VSP passes a window over segments of 
the site and calculates the anomaly density for each segment. The window diameter 
specifies the size of the circular area over which the average density is computed.  Figure 
18 shows where the window diameter is selected in this VSP analysis dialog.  Figure 19 
provides an example of how the window diameter is used to calculate transect grid 
densities.  The window diameter defines the size of a centered circular window (orange 
and blue circles in Figure 19), which moves every one-sixth of the selected diameter and 
uses the anomaly count with the transect area within the window to calculate a density 
assigned to the central transect grid (orange and blue boxes in Figure 19) centered in the 
window.  Each grid has dimensions of one-sixth the window diameter.  The green dots in 
Figure 19 represent the identified anomalies within the two surveyed transects.  This 
figure provides an example of two of the multiple transect grid densities which would be 
calculated on these transects. 
 
The selection of an appropriate window diameter is dependent on the size of the target 
area of interest, transect width, and spacing between transects.  The optimum window 
diameter is one which has sufficient traversed transect area within the window without 
including such a large area that potential high density areas can be masked by the 
surrounding low density areas in the window.  The blue window in Figure 20 provides an 
example of a window that is too large.  If the window diameter is too small (red window 
in Figure 20), then the limited amount of traversed transect area within the window is not 
sufficient to make accurate transect grid density estimates.  Within these two extremes, 
there are often many different window diameters that would be appropriate.  As a general 
rule, the window diameter should be less than the diameter of the target area of interest 
and no smaller than the spacing between the original transect design.  Selecting the 
appropriate window diameter for each specific site analysis is currently left to the user. 
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Figure 18.  “Locate and Mark UXO Target Areas Based on Elevated Transect Anomaly Density” dialog 
where the window diameter is specified. 
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Figure 19.  Depiction of the window density calculation process used in the process to identify high 
density regions within a site. 
 
   

 
 
Figure 20.  Example of different window sizes and how they would encompass the transects. 
 



 30

3.2.2. Evaluating the Anomaly Density Distribution of the Site 
 
Using the moving window algorithms above, VSP provides a histogram of the anomaly 
densities across the site.  In cases where the anomaly density distribution of the site is 
unknown and there is no reliable historical data to use as an estimate, a histogram of the 
density calculations for the entire site can provide a good understanding of the anomaly 
density distribution.  These density calculations use the information from the transect grid 
densities (see Figure 19) but include an additional averaging computational routine to 
remove overlapping transect grid density values from the histogram.   The primary 
purpose for this histogram is to help select a critical density above which areas will be 
flagged by distinguishing between high density target areas and lower density 
background values.   
 
The three histograms in Figure 21 are shown to illustrate one way in which densities 
associated with background and densities associated with a potential target area appear 
when combined into one histogram.  The top histogram shows an example of background 
densities with an average density of 15 ApA and standard deviation of 15 ApA.  The red 
line marks the point below which 99 percent of the background densities lie, assuming a 
Gamma distribution for the background grid densities.  The middle histogram shows a 
possible distribution of target area transect grid densities for an area which had an 
average density of 50 ApA and standard deviation of 10 ApA.  The green line marks the 
point above which 99 percent of the densities lie when the distribution of target area 
densities follows a normal distribution.  The bottom histogram combines the information 
from the other two histograms to show what would be seen when analyzing a site with 
these characteristics within VSP.  The histograms in Figures 21 through 24 are generated 
histograms for demonstration and do not represent the transect grid densities at any 
specific site.   
 
In the example from Figure 21 the target area densities fall in the tail of the background 
densities and the critical density would be selected somewhere between 20 and 35 ApA.  
The bottom histogram in  Figure 22 shows an example of an average target area density 
that is much larger than the average background density, which would make it very easy 
to identify a critical density that flags transect grids that are only associated with the 
target area.  Figure 23 and Figure 24 show how the combined histograms are affected 
when the size of the target area is small (Figure 23) or large (Figure 24) and the average 
target area density is not as distinguishable from the average background density.  It is 
not clear that an appropriate critical density could be selected using only the bottom 
histogram in Figure 23, but the critical density from the bottom histogram in Figure 24 
would be somewhere between 18 and 25 ApA.  As explained, the examples in Figures 21, 
22, and 24 would be sites where the histogram alone could provide a good understanding 
of the density distributions on the site and possible critical densities.  It would be more 
difficult to understand the combination of density distributions or an appropriate critical 
density in cases represented by the bottom histogram in Figure 23.   
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Figure 21.  The gamma distribution of background densities with an average density of 15 ApA and a 
standard deviation of 15 ApA (top).  The Gaussian distribution of target area densities with an average 
density of 50 ApA and a standard deviation of 10 ApA (middle).  The bottom histogram is an example of 
the of the combined density distribution.  The green line at 27 ApA is the point at which 99 percent of the 
target area densities are larger.  The red line at 70 ApA is the point where 99 percent of the background 
densities are smaller. 
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Figure 22.  The gamma distribution of background densities with an average density of 8 ApA and a 
standard deviation of 8 ApA (top).  The Gaussian distribution of target area target area densities with an 
average density of 120 ApA and a standard deviation of 20 ApA (middle).  The bottom histogram is an 
example of combined density distribution.  The green line at 73 ApA is the point at which 99 percent of the 
target area densities are larger.  The red line at 37 ApA is the point where 99 percent of the background 
densities are smaller. 
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Figure 23.  The gamma distribution of background densities with an average density of 25 ApA and a 
standard deviation of 25 ApA (top).  The Gaussian distribution target area densities from a small target area 
with an average density of 40 ApA and a standard deviation of 10 ApA (middle).  The bottom histogram is 
an example of combined density distribution.  The green line at 18 ApA is the point where 99 percent of the 
target area densities are larger.  The red line at 115 ApA is the point where 99 percent of the background 
densities are smaller. 
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Figure 24.  The gamma distribution of background densities with an average density of 25 ApA and a 
standard deviation of 25 ApA (top).  The Gaussian distribution of target area densities from a large target 
area with an average density of 40 ApA and a standard deviation of 10 ApA (middle).  The bottom 
histogram is an example of combined transect grid density distribution.  The green line at 18 ApA is the 
point where 99 percent of the target area densities are larger.  The red line at 115 ApA is the point where 99 
percent of the background transect grid densities are smaller. 
 
Figure 25 and Figure 26 are histograms of the site densities from the transects shown in 
Figure 2.  This is an actual site studied as a part of the larger Wide Area Assessment 
project funded by ESTCP.  This site is located in northern California and is a small part 
of the larger Victorville Precision Bombing Range (Hathaway 2006).  Figure 26 shows 
the same densities as Figure 25, but the frequency axis is transformed logarithmically to 
accentuate the lower count bins.  This transformation is done by clicking the “Log Y” 
box when examining the histogram within VSP.  This site had multiple high density areas 
of which each had a unique average density.  Figure 26 provides a view that is similar to 
what is shown Figure 24.  This histogram helped in selecting 45 ApA as the threshold 
used to identify all the high density areas on the site (Hathaway 2006).      
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Figure 25.  Histogram produced using the “Find UXO Target Areas” target area identification dialog in 
VSP of the calculated site densities from a survey performed at wide area assessment site located near 
Victorville, California.  The window diameter was 300 m and the red line at 45 ApA marks a possible 
critical density.  
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Figure 26.  Histogram produced from VSP using the same data from Figure 25, but the frequency axis is 
transformed to accentuate the bins with low counts. 
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3.2.3. Selecting a Critical Density for identification 
 
The selection of a final threshold that identifies and delineates all the specified target 
areas must use the spatial location of the high density areas with the information provided 
in the histograms explained previously.  The final threshold will identify the maximum 
boundaries of the clustered high-density regions without including a lot of small sparsely 
located regions on the site.  Figure 18 shows the dialog in VSP that provides the user with 
tools to identify the high density areas.   
 
The “Locate and Mark UXO Target Areas Based on Elevated Transect Anomaly 
Density” provides a method to flag locations within the transects that have an anomaly 
density above a selected critical density.  This method does not attempt to estimate 
anomaly densities between the transects and only requires the user to select a window 
diameter and density threshold to perform an analysis of a site.  This method “flags” 
those areas on the transects that have densities above the specified threshold (see Figure 
27). 
 
Figure 27 depicts a transect survey done in southern California on a smaller section of the 
Victorville Precision Bombing range which was explained previously.  This site was 
approximately 5500 acres and included two previously identified impact areas.  The 
general locations of Areas E, F, and H were previously identified as munitions related 
impact areas.  However, there was no other information that identified the remaining 
regions as munitions related.  Further work on this site showed that the remaining regions 
of high anomaly density were due to geology.  This site is a good example of the 
limitations of these tools.  Identified and delineated regions are only based on the number 
of identified metallic related signals from the survey equipment.  These high density 
areas will include any munitions related areas but may also include areas with high 
densities from geologic or anthropogenic material. 

3.2.4. Identifying UXO Target Areas Based on Elevated Transect 
Anomaly Density 

 
The flagging routine in VSP uses the transect grid densities calculated as described in 
Section 3.2.1 along with the selected critical density to “flag” those grids that are above 
the critical density with the use of the dialog shown in Figure 18.  The “flags” are sized to 
represent one-sixth of the window diameter used during the analysis.  When using this 
dialog, the user can select “Flag areas with density significantly > background” or “Flag 
areas with density > critical density” to flag high density areas on the site.  The dialog 
shown in Figure 28 allows the user to input the average background density if known and 
identify those transect grids with an anomaly density significantly greater than the 
average (Matzke, 2006).  The examples provided in this section use “Flag Areas with 
Density > Critical Density” (Figure 18) to demonstrate how a critical density and 
window diameter would be selected during an analysis.  
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Figure 27.  Depiction of different flagged areas based on a 300-m-diameter window (bottom two maps) 
and a 650-m-diameter window (top two maps) when a critical density of 25 ApA (left two maps) or  
45 ApA is used (right two maps).   
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Figure 28.  “Locate and Mark UXO Target Areas Based on Elevated Transect Anomaly Density” design 
dialog when an average background density and associated confidence are selected to flag high density 
transect grids on the site. 
 
The distribution of the site densities is affected by the size of the window diameter used 
during the analysis.  Figure 30 shows the distribution of these densities for the Victorville 
site when a 300-m-diameter window is selected while Figure 29 is the same site but uses 
a 650-m-diameter window.  These two figures provide an example of how the 
distribution of site densities and the optimum critical density are affected by the selected 
window diameter.  The histogram which used a 650-m-diameter window has a reduced 
maximum value and many of the low density values have moved from zero to slightly 
higher values.  It should also be noted that a larger window diameter also increases the 
window step size which reduces the number of windows (individual density estimates) on 
the site and in the histogram.  As different window diameters are examined, the resulting 
histograms should be analyzed to find an appropriate critical density for the respective 
diameter selected.   
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Figure 29.  Distribution of transect grid densities for the Victorville site when a 650-m-diameter window is 
selected.  The red lines represent a possible critical density of 25 ApA. 
 
Figure 27 shows the flagged areas for the Victorville site based on the use of a 650-m-
diameter window (top two maps) or a 300-m-diameter window (bottom two maps).   The 
two maps on the left are flagged with a critical density of 25 ApA and the two maps on 
the right use a critical density of 45 ApA.  Figure 27 exhibits four different perspectives 
of the survey data and provides a small example of the iterative process of identifying the 
proper window diameter and critical density combination.  The map in the lower right 
uses a 300-m-diameter window with a 45 ApA critical density and was used during the 
analysis of this data to identify the labeled areas which are shown in all four maps 
(Hathaway 2006).  The other three maps show an example of the iterative process used to 
select the combination of 300-m-diameter and 45 ApA.  The map in the upper left tends 
to identify all the high density areas, but the large window diameter (650 m) and low 
critical density (25 ApA) appear to include too much area around the perimeter of each of 
the high-density areas.  This window diameter fails to identify any high density grids near 
area of interest I (AOI-I).  The map in the lower left (300 m) uses the same critical 
density of 25 ApA and identifies all the identified AOI; however, there are many smaller 
flagged regions which are sparsely located over the site.  Finally, the map in the upper 
right identifies five tightly clustered high density regions without a lot of additional area 
included around these identified areas, but the combination of a 650-m-diameter window 
and a 45 ApA critical density made the map in the upper right the only one that did not 
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identify AOI-E, AOI-F, and AOI-G.  In summary, the resulting final flagged areas are a 
function of the user-defined values of the critical density and the window size. 
.     

4. Geostatistical Mapping of Anomaly Density 
 
To this point in the analysis, the questions being asked and the calculations and products 
produced using VSP have been confined to the actual data that have been collected.  The 
next step is to exploit the collected data to provide details, albeit estimated details, of the 
areas outside of the sampling transects.  For example, what does the target area boundary 
look like between the relatively small number of points where it intersects the transects?  
Also, what is the best estimate of the total number of anomalies contained within the 
target area?  To fill in these types of details, it is necessary to extrapolate the collected 
data away from the transects in a repeatable and defensible manner.  We accomplish this 
goal using geostatistical estimation tools 
 
The geostatistical mapping of anomaly densities provides a continuous estimate of the 
density of magnetic anomalies for the entire study site.  This spatially continuous 
representation is important in the visual detection of high-density areas.  This estimation  
also provides the basis for estimating the total number of anomalies within portions of the 
site as used in cost estimating and in providing a basis for other spatial analyses such as 
target boundary delineation.  The basic output from this process is a map showing an 
estimate of how the magnetic anomaly density varies across the study site.  This map is 
composed of a number of equal sized cells, typically on the order of 50 by 50 m, and the 
estimation process provides the spatially varying average anomaly density within each 
cell across the site. 
 
Within VSP, the geostatistical anomaly density mapping is composed of two primary 
tasks.  The first task is modeling of the spatial variability of the measured anomaly 
densities as determined from the geophysical transect data.  This task involves the 
development of a variogram based on the window-averaged transect density values.  A 
variogram depicts how the variability of a set of values changes as the distance between 
the spatial locations of these values increases.  The second task involves the estimation of 
anomaly density at unsampled locations within the study area through a geostatistical 
methodology know as kriging.  Kriging uses the model of spatial variation as captured by 
the variogram to provide an unbiased, minimum-variance estimate of the anomaly 
density.  Kriging is the procedure that creates the final anomaly density map. 
 
An anomaly density map can be created from the sample transect data by opening the 
“Geostatistical mapping of anomaly density” dialog (Figure 30).  This dialog is opened 
though the Sampling “Sampling Goals > Find UXO Target Areas > Geostatistical 
mapping of anomaly density” selection.  This selection presents a menu with three 
screen tabs.  The default tab “Map Anomaly Density” presents several options for 
mapping anomaly densities.  The second tab “Variogram Model” provides an alternate 
means of accessing variogram fitting parameters once the variogram has been computed.  
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The third tab “Data Entry and Analysis” provides the ability to import files identifying 
the course over ground and anomalies as explained in section 3.1.   
 
There are two pathways to create the anomaly density estimates.  The basic pathway will 
create an estimate of anomaly density based on a series of default values computed from 
the current data set.  The advanced pathway allows more control over the variogram and 
kriging parameters, but requires the user to possess a greater understanding of geo-
statistical analysis to be used in a meaningful manner.  Each of these pathways is 
discussed below. 
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Figure 30.  “Geostatistical Mapping of Anomaly Density” dialog.  This view shows the basic mode 
without the advanced operations screen box displayed. 

4.1. Basic Geostatistical Mapping 
 
Under the default “Map Anomaly Density” tab of the “Geostatistical mapping of anomaly 
density” dialog, the user is presented with two choices for computing the anomaly density 
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map.  In “Basic Mode,” the VSP will automatically compute a variogram and perform the 
kriging necessary to develop a spatial estimate of anomaly density.  In this mode, a series 
of default values are computed for the data set and used in the variogram and kriging 
analyses.  This mode is fully automatic and is the recommended path for new users to 
follow.   
 
To use the automatic mode, click on the “Launch” button within the “Basic Mode” screen 
box (Figure 30).  Clicking on this button will launch a series of programs that will 
momentarily flash several operational windows to the screen before returning to the 
“Geostatistical Mapping of Anomaly Density” dialog.  After successful completion of 
this process, the modeled variogram can be viewed by clicking on the “Variogram 
Model” tab in the “Geostatistical Mapping of Anomaly Density” dialog.  Clicking on the 
“OK” button will close this dialog and load the anomaly density estimate map as an 
overlay onto the main VSP site map.  At this point, the primary VSP mapping tools can 
be used to investigate the details of the estimated anomaly density map.   
 

4.2. Advanced Mode Geostatistical Mapping 
 
In the “Advanced” mode, the user is given complete control over all the parameter 
settings involved in the variogram and kriging analysis.  This mode is recommended for 
experienced users or when specific analysis parameters are necessary. 
 
Advanced mode is selected by clicking on the “Advanced” button under the “Map 
Anomaly Density” tab of the “Geostatistical Mapping of Anomaly Density” dialog.  
Clicking on this button will open a screen box with various selections for advanced mode 
operation (Figure 31).  These selections include the averaging window diameter, a check 
box to select indicator kriging, and a check box to reset negative estimate values.   
 
The averaging window diameter parameter specifies the size of the averaging window 
used in computing the anomaly density values used in the geostatistical mapping.  The 
impact of this parameter on anomaly density calculations is discussed in Section 3.2.1.  
The variogram lag distance and kriging grid cell size are also affected by this parameter.  
The lag distance is the separation distance between pairs of data points and is used to 
group the data pairs and is discussed further below.  The initial lag spacing and kriging 
grid cell size are set to be one-sixth of the averaging window diameter by default.  If an 
averaging window diameter other than the default value is desired, it should be changed 
before proceeding with the next steps in the analysis.  The initial lag spacing and kriging 
grid cell size also can be changed independently of the window size by manually entering 
them using the advanced mode.   
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Figure 31.  Advanced mode for geostatistical anomaly density mapping. 
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Checking the selection box labeled “Indicator Kriging” in the advanced mode window 
will produce probabilistic estimates of exceeding a specified anomaly density threshold.  
In contrast to the standard kriging of anomaly density values, indicator kriging transforms 
the observed anomaly density values into an indicator variable based on a specified 
anomaly density threshold.  Measured anomaly density values at or above this threshold 
are given a value of 1, while observations below the threshold are assigned a value of 0.  
These indicator variable values of 1 and 0 are then used in the variogram calculation and 
modeling and in the kriging estimation in place of the original anomaly density values.  
The kriging estimates resulting from this then range from 0 to 1 and represent the 
probability of exceeding the specified anomaly density threshold.  When the indicator 
kriging checkbox is selected, an additional window for specifying the anomaly density 
threshold value is provided.  This value should be entered in standard units of anomalies 
per acre. 
 
The final selection option displayed in the advanced mode window is the option to reset 
negative estimate values.  This selection is checked on by default.  Under certain 
circumstances, the kriging equations can sometimes produce estimates outside of the 
range of the original conditioning data.  This may lead to negative anomaly density 
values within the kriging estimation.  Because this is physically impossible, the option is 
given to reset negative estimation values to zero before the results are displayed within 
VSP.  This option should remain selected unless there is a compelling reason to 
investigate the untransformed kriging values. 
 
The following discussion presents details regarding advanced mode operation for the 
geostatistical estimation procedure.  Although the examples that are presented focus on 
anomaly density estimation, the same basic procedures are applicable for indicator 
kriging.  In cases where differences do exist, additional information regarding the 
indicator kriging procedure is provided. 
 
Once the processing options have been set, the first processing step in using “Advanced 
Mode” is to click on the button labeled “GAM/GAMV.”  This selection will initiate the 
variogram calculation and then open a separate screen presenting a graphical interface for 
additional variogram analysis.  At this point, the automatically fit variogram model can 
be viewed by clicking on the “Fitting” tab of the GAM/GAMV” screen (Figure 32).  
Here, the user will see the empirical variogram values as well as the automatically fit 
variogram model and its parameters (Figure 33).  The variogram is computed from the 
averaged anomaly density values obtained from the geophysical survey transect data.  
The averaged anomaly densities are automatically computed using the averaging window 
diameter specified under the “Advanced Options” screen box, and the previously loaded 
anomaly locations and course over ground information.  These values are then 
automatically passed to the GAM/GAMV code.  In the case of indicator kriging, the data 
that is passed to the GAM/GAMV code are the 1 and 0 values of the indicator variable 
created using the specified anomaly density threshold. 
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Figure 32.  Aspects of the GAM/GAMV interface screen. 
 
 
 

 
 
Figure 33.  Variogram fitting screen from the GAM/GAMV window.  Dots show computed variogram 
values, and the solid green line shows the model fitted to variogram values.  Parameters for this model are 
listed along the left side of the window. 
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There are various other tabs in the GAM/GAMV screen that provide access to other 
variogram analysis parameters.  Details regarding these other input parameters are given 
in GAM/GAMV interface interactive help files, and a full discussion can be found in 
Deutsch and Journel (1998).  When running within the VSP environment, the data file 
and output file names should never be changed from their default values.  In general, the 
only control parameters that might typically be altered at this stage in the analysis are the 
lag spacing, lag tolerance, and number of lags to compute.  These parameters control how 
the observations for computing the empirical variogram are grouped and the maximum 
separation distance that should be considered.  These parameters are discussed further 
below. 
 
The GAM/GAMV code is used to compute a variogram for the averaged anomaly density 
data.  A variogram depicts how much the variation between pairs of sample values 
(anomaly density in the case here) changes as the distance between pairs increases. The 
lag distance is the separation distance between pairs of data points.  The lag distance is 
used to group the data pairs into groups based on separation distance.  Then the “semi-
variance” is computed for each group and plotted as part of the empirical variogram.  
Because most sample points will not be separated by exactly the specified lag distance, 
the lag tolerance is given to include those observations that are within the tolerance value 
of the specified lag distance.  For example, using a lag distance and tolerance of 200 m 
and 100 m, respectively, will generate the following grouping of separation distances: 
 

 0 to 100 m   group 1 
100 to 300 m   group 2  
300 to 500 m  group 3 

 
A semi-variance, or “Gamma”, value for each group is then computed using all the data 
points with separation distances falling within the distance boundaries for that group.  
The separation distances are simply the straight line distances between the sample pairs 
based on the sample point locations.  The computed semi-variance values are then plotted 
along with the average separation distances for each group to create an empirical 
variogram (Figure 33).  The empirical variogram is a graph showing one-half the average 
squared differences between all pairs of observations for a series of average lag distances. 
   
The solid dots in Figure 33 show the computed empirical, or experimental, variogram 
values for specific lag distances.  The X-axis shows the lag distance in length units 
(meters in this case), and the Y-axis shows the computed semi-variance value.  In this 
example, the lag distance was 200 m and the lag tolerance was 100 m.  The actual 
location of each data point on the X-axis is determined by the average actual lag distance 
of all the data pairs in that group.  The solid green line shows the automatically fit 
variogram model for this data set. 
 
One-half the average squared difference for all of the pairs of observations for each group 
will show up as a single data point on the experimental variogram.  Within VSP, the 
along transect data point spacing is controlled to be one-sixth the averaging window 
diameter; this is typically the minimum lag distance that should be used.  This minimum 
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value is a good place to start the variogram analysis and typically is sufficient for most 
studies.  To include all data points and avoid overlap between variogram point groups, 
the lag tolerance should be set to one-half the lag distance.  After changing any of the 
GAM/GAMV input parameters, the variogram will need to be recomputed by clicking on 
the “Compute Empirical Variogram” button (Figure 32).  This selection will recalculate 
the empirical variogram and display the results under the “Fitting” tab. 
 
The “Fitting” tab of the GAM/GAMV window (Figure 32) interface will display the 
computed empirical variogram, and will also automatically compute an initial model to 
fit the data points.  This model consists of a continuous function that closely matches the 
distribution of the empirical variogram data points.  A continuous function that will 
produce a positive definite covariance matrix for solution of the kriging equations is 
required as a model of spatial variability.  Although a single model typically is sufficient, 
up to three different models can be simultaneously nested to provide a proper fit to the 
empirical data points.  Excessive time should not be spent in creating a best fit model of 
the empirical variogram data.  Typically, the focus of the variogram model fitting should 
be on matching the experimental variogram points at the shortest lag spacings and at the 
variance of the data set, shown by the solid horizontal black line, which provides the 
theoretical maximum variogram value (see Figure 34).  A reasonably good fit is usually 
sufficient when using a transect survey data set.  
 

 

 
 

Figure 34.  Variogram model parameters settings within the GAM/GAMV graphical interface. 
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The variogram model is reshaped by changing the range, nugget and sill values (Figure 
34).  The sill controls the height of the variogram model while the range controls the 
distance scale of the model.  If a large initial jump in the variance is needed to match the 
empirical data, the nugget value can be increased.  The nugget, sill, and range can be 
adjusted to match the computed variogram data points as needed.  In addition, the basic 
model type (spherical, Gaussian, exponential, etc.) can also be changed as needed.  The 
variogram model line will update dynamically as any of the modeling parameters are 
altered. 
 
Figure 35 shows the effects of changing the range and sill values of the variogram model.  
The sample anomaly data for these plots were from a magnetometer survey of a portion 
of the Pueblo Precision Bombing Range located in southeastern Colorado.  The 
magnetometer transects from this survey were nominally spaced at 155 m and crossed 
two large high-density areas.  As seen in these plots the range and sill values can be 
adjusted until a sufficiently close match to the empirical data is made. 
 
 

 
 
Figure 35.  Effects of changing sill and range values for variogram model.  Left column of plots shows 
effects of altering range value; right column shows effects of altering sill value.  In each plot, dots represent 
empirical variogram values, and the green line shows model variogram. 
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Once the variogram model is satisfactorily fit, the GAM/GAMV interface can be closed, 
which automatically saves the variogram model parameters.  The next step is to use the 
information in the variogram model to create a map of the anomaly density (or 
probability, if indicator kriging is used) across the site.  The spatial estimation tool is 
“KT3D.”(Deutsch and Journel, 1998)  To begin, click on the KT3D button within the 
“Geostatistical Mapping of Anomaly Density” dialog.  This will open the KT3D 
graphical user interface.  The variogram model parameters developed using 
GAM/GAMV will automatically be passed to KT3D. 
 
The KT3D interface provides full control of all parameters for the KT3D kriging code.  A 
number of default parameters are already set, so the code can be run immediately by 
clicking on the “Run” button (Figure 36).  This will generate a kriging estimate and 
display the results within the KT3D interface screen.  To display the kriged estimate 
within VSP, simply close the KT3D interface screen then click “OK” or “Apply” within 
the “Geostatistical Mapping of Anomaly Density” dialog box. 
 
The other advanced options for running KT3D can be accessed through the various tabs 
under the main “Parameters” tab on the interface screen.  A complete explanation of 
these various options is presented in the associated help files contained within the KT3D  

 
Figure 36.  KT3D interface screen. 

 
tool.  When running within the VSP environment, the observation data file and kriging 
output file names should never be changed from their default values. 
 
The KT3D parameters most likely to be changed from their defaults are the gridding and 
search parameters.  These parameters, which control the number, size, and extent of the 
estimation cells used to discretize the site and the search of local data to be used in the 
estimation of any location, respectively, are located under the “Grid” and “Search/ 
Discretization” tabs.  A full explanation of these parameters can be found in help files 
associated with the KT3D program, and a full discussion on the background of kriging 
estimation can be found in Deutsch and Journel (1998). 
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After all the parameters are set, the user clicks on the “Run” button to run KT3D.  The 
kriging results are automatically displayed within the KT3D interface sub-window.  In 
addition to the anomaly density estimate, the kriging variance also is displayed in an 
adjacent window.  Closing the KT3D interface window will take you back to VSP and 
the “Map Anomaly Density” dialog.  Clicking on “OK” or “Apply” will display the 
kriging results in the VSP display. 
 

4.3. Display of Kriging Results within VSP 
 
Whether run from “Basic” or “Advanced” mode, clicking on the “Apply” or “OK” button 
in the “Map Anomaly Density” screen will display the current kriging results within the 
VSP mapping window.  The anomaly density or probability map is displayed in VSP as a 
color-shaded value map.  Figure 37 shows kriging results displayed in VSP.  The 
anomaly density estimate in Figure 37 was developed from magnetometer surveys from a 
portion of the Pueblo Precision Bombing Range.  This site is a World War II era bombing 
range that shows evidence of two large target areas.  The default color scheme in the map 
display has the highest density values shown in red and the lowest values shown in green.  
A color scale is provided to aid in interpretation of the results.  The lack of color shading  
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Figure 37.  Results of anomaly density kriging estimation displayed in VSP. 
 
(background color is displayed) indicates that no kriging estimation was performed for 
that location.  This typically is the result of a lack of enough sample transect data within 
the search window for reliable estimates within that area.  An example of this can be seen 
in Figure 38 as a gray area in the northern portion of the study area.  Survey transects 
were not collected in this area because of vegetation and terrain issues.  Because of this 
gap, no kriging estimates were developed for this area.   
 
During examination of the anomaly density map it is useful to turn on the display of the 
transect survey traces and the detected anomaly locations as aids in interpreting the 
anomaly density map (Figure 38).  The controls for turning different map elements on 
and off are located under the “View” menu on the main VSP screen.  This menu provides 
a listing of different mapping elements which can be checked on or off to control their 
display.  The transect survey traces and detected anomaly locations provide a visual 
relationship between the kriging results and the support data used in the kriging analysis.  
For example, the transect traces shown in Figure 38 explain the gap in the kriging results 
in the northern portion of the Pueblo Precision Bombing Range study area.   
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Figure 38.  Results of kriging estimation displayed in VSP along with COG traces and anomaly locations. 

 
The color scheme used for the anomaly density display can be changed by selecting the 
“View” pull down menu on the main VSP screen, then choosing “Kriged Data,” and then 
selecting “Color Options.”  Various color palettes are available.  Selecting one with a 
larger color range will bring out more details in the anomaly density estimate.  Figure 39 
shows the same anomaly density estimate for the Pueblo Precision Bombing Range as 
shown in Figure 37, but it uses a different color palette (MBCGYOR-Grad) to enhance 
the variations in anomaly densities, thus bringing out some of the subtle details in the 
higher density areas. 
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Figure 39.  Kriging results displayed in VSP using an alternate color scheme. 
 
In addition to the estimate of anomaly density or probability, the kriging procedure also 
generates a map of the estimation variance.  Figure 40 shows the kriging estimation 
variance computed for the kriging results from the Pueblo Precision Bombing Range 
study area.  The estimation variance shows the uncertainty of the kriging estimate and is a 
function of the data configuration and the variogram model.  Estimates of anomaly 
density for locations on or near sampling transects should be very accurate and, hence, 
have a low uncertainty.  Conversely, estimates distant from the sample transects are 
likely to be less accurate with a relatively high uncertainty.  The value of the estimation 
variance reaches a maximum at distances greater than or equal to the variogram range 
away from the nearest data point.  The map of estimation variance shows how the 
variance of the anomaly density changes across the study site.  In Figure 40, the highest 
variance values are shown in shades of red; the lowest values in shades of green.  The 
highest variance values occur in the northern portion of the site where there is a large gap 
in the sample transects because of terrain and vegetation issues.  The maximum variances 
occur on the edge of the region where no estimates could be made.  These high variance 
values indicate that some areas exist within the site where there are enough nearby data 
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points to create a kriging estimate, but the uncertainty in these estimates is large.  While 
not explored further here, the kriging variance provides a means of identifying regions of 
high uncertainty and can be used to design additional transect surveys.  The lowest 
variance values are found at the survey transect locations. 
  
 

 
 
Figure 40.  Kriging variance displayed in VSP along with COG traces.  The highest variance values are 
shown in red, and the lowest values are shown in green. 
 
To view the estimation variance, select the “View” pull-down menu on the main VSP 
screen, then choose “Kriged Data,” and then select “Kriging Variance.”  As shown in 
Figure 40, there is a strong relationship between the sample transect locations and the 
kriging variance.  The variance is low closest to the transects and increases with 
increasing distance from the sample locations.  This can be used as a quick check to 
confirm that all the appropriate sample data have been included in the kriging analysis 
and to identify areas where the confidence in the kriging results could be increased with 
additional sample data. 
 
If desired, the anomaly density estimates and variance values can be exported to a file 
format that is compatible with the ESRI ArcGIS geographic information software system.  
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This is done by selecting “Map > Map Layers > Export” from the main VSP screen.  
This will provide options for exporting the current kriging estimates or the kriging 
variances.  Maintaining the filename extension of “ASC” will provide direct recognition 
of the export file within ArcGIS.  This export file format can be directly read into 
ArcGIS. 
 

5. Delineating High Density Areas 
 
As seen in Figure 37 there appear to be two main high anomaly density areas at the  
Pueblo Precision Bombing Range; one in the northern part of the site, and a larger area in 
the south.  The anomaly density, transect coverage and kriging variance (Figure 38 and 
Figure 40) confirm that these areas are well sampled and contain a large number of 
magnetic anomalies.  At this point, the anomaly density estimate map can be used as a 
tool to identify those high density areas which are probable former target locations.   
 
The initial step in target area delineation is to focus the kriging anomaly density estimate 
so that only high-density locations are displayed.  The results from this process are very 
similar to those obtained from the density flagging routine (see Section 3.2.3).  The goal 
is to adjust the color range used to display the kriging results so that only those high-
density areas that are likely target locations are displayed.  This provides an interactive 
analysis technique that gives rapid feedback on the spatial extent of potential target areas.  
This process can be performed within VSP, or the kriging estimates can be exported and 
brought into ArcGIS for this analysis. 
 
To change the kriging display within VSP, go to “View > Kriged Data > Color 
Options.”  This will present a dialog box that will allow the user to change the minimum 
and maximum display values.  Change the minimum display value to a value that is 
considered to be slightly above background.  This will change the kriging data display to 
show only those values above the selected minimum.  Changing the minimum display 
density is similar to setting the critical density in the VSP flagging routine (Section 
3.2.3).  Review of the spatial distribution of the kriging display will lead to refinement in 
this critical density value (see below).  This interactive technique is iterative, thus 
allowing different critical density cutoff values to be investigated.  A more automated 
technique is currently under development for inclusion into VSP. 
 
To perform the critical density analysis within ArcGIS, first export the kriged density 
estimate data (see Section 4.3) to an ASCII file, and then import this file into ArcGIS. 
Once imported, the anomaly density data will be displayed as a color-shaded grid similar 
to that used in VSP.  At this point, the display properties can be altered in a similar 
fashion to that used in VSP to control the critical density cutoff level.  This process 
requires some familiarity with ArcGIS and how to control the symbology of the 
displayed layers. 
 
Regardless of whether the target boundary identification is done within VSP or ArcGIS, 
the process of using critical density cutoff levels is similar.  The process of investigation 
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of different cutoff levels is shown in Figure 41 through Figure 43.  Figure 41 shows the 
anomaly density display resulting from using a critical density level that is too low to 
allow accurate delineation of specific target areas.  In this figure, several compact high 
density areas (shown in red) are displayed, but they are surrounded by halos of irregularly 
shaped low density areas (shown in green).  The irregular shape and discontinuous nature 
of these green areas indicates that they more likely related to the background anomaly 
distribution at the site rather than to any concentrated munitions use which would be 
expected for a target area. 
 
Figure 42 shows the anomaly density display resulting from using a critical density level 
that is too high to provide assurance that all the major target areas have been identified.  
In this figure several of the original compact higher density areas have been dropped 
from the display, including the high density area in the northern portion of the study area.  
In addition, the size of the high density area in the southern part of the Pueblo Precision 
Bombing Range site has been dramatically reduced. 
 
Figure 43 shows the anomaly density display resulting from a more appropriate choice of 
anomaly density cutoff level.  In this figure, the highest density areas are represented by 
continuous compact features (shades of yellow and red) that do not have excessive 
fingering around their perimeter.  Several large high density areas can be readily 
identified as likely target areas.  Additional smaller, low-density areas are also present, 
but the history of this site (i.e., an aerial bombing range) suggests that these areas are too 
small in scale to be considered as likely target areas.  With the exception of the small, 
isolated low density areas, the areas shown in Figure 43 can be used as boundaries for 
delineating likely target areas. 
 
As an example of how indicator kriging can be used in the delineation of high density 
areas, Figure 44 shows indicator kriging results for the Pueblo Precision Bombing Range 
using the same transect data as used to generate the anomaly density estimates shown in 
Figure 43.  The example indicator kriging results shown in Figure 44 are based on 
investigating an anomaly density threshold of 40 ApA.  The values shown in Figure 44 
depict the probability of exceeding this threshold value.  The color-shading shows those 
locations with a probability greater than 0.05 of being above the threshold value.  Ther is 
less than a 5% chance of the anomaly density being equal to or greater than 40 ApA at 
any location with a grey color.  This information could then be used in a probabilistic 
assessment of high density areas based on this threshold value.  Other threshold values 
could also be investigated to aid in delineating the high density areas of concern. 
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Figure 41.  Anomaly density display for the Pueblo Precision Bombing Range WAA site resulting from 
selection of a critical density cutoff level that is too low.  The highest anomaly density areas are shown in 
red, and the lowest density areas are shown in green.  Gray areas show locations where the anomaly density 
is below the critical density.   
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Figure 42.  Anomaly density display for the Pueblo Precision Bombing Range WAA site resulting from 
selection of a critical density cutoff level that is too high.  The highest anomaly density areas are shown in 
red, and the lowest density areas are shown in green.  Gray areas show locations where the anomaly density 
is below the critical density.   
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Figure 43.  Anomaly density display for the Pueblo Precision Bombing Range WAA site resulting from 
selection of an appropriate critical density cutoff level.   The highest anomaly density areas are shown in 
red, and the lowest density areas are shown in green.  Gray areas show locations where the anomaly density 
is below the critical density.   
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Figure 44.  Example indicator kriging results using a threshold of 40 ApA.  Color-shading depict 
probabilities of being above the threshold value.  Value range for color-shading (green-red) is from 0.05 to 
1.
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6. Post-Survey Probability of Traversal 
 
The “Post-Survey Probability of Traversal” dialog is shown in Figure 45.  This dialog 
uses the COG data to identify any locations on a site where a target area of the shape 
defined in the “Target Zone” tab could be located and not traversed.  The map shown in 
Figure 46 contains a small portion of the Victorville site described in Section 3.2.3.  The 
points identified on this map are the center points where a 500-ft-diameter target area 
could be located and not traversed   As the “Detection Simulation” tab in Figure 45 
shows, the transects within this area had an 82 percent  probability of traversing all 
possible 500-ft-diameter target areas. 
 

 
 
Figure 45.  “Post-Survey Probability of Traversal” dialog used to assess the probability of traversal based 
on the actual transect survey.  This dialog has the “Detection Simulation” tab (left) and the “Target Zone” 
tab (right).  
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Figure 46.  Example of the map view after clicking on the “Simulate” button on the “Detection 
Simulation” tab of the “Post-Survey Probability of Traversal” dialog. 

7. Using VSP Analyses in Reports and External Software 
 
Upon completion of a site analysis, the information within the VSP project file can be 
exported for use in external software or for use in reports.  All the map information 
shown in Figure 27 can be exported using the ArcGIS SHP format.  This option, which is 
found by selecting “Map > Export > to SHP” from the VSP menus, opens the export 
dialog shown in Figure 15.  When exporting data from an analysis, all the files listed in 
Figure 15 will be checked.  The user can clear the box for those files that do not need to 
be exported and click on the “File” button to change the location of the saved file.  All 
the necessary files for use with external GIS software are included when the SHP file is 
created. 
 
The data entry tab explained in Section 3.1 allows the imported COG and anomaly files 
to be exported from VSP to a file in ASCII format.  These data are shown in Table 4.  
The dark black lines separate the three data sets.  The COG data is on the left and has 
three columns.  Two columns identify the X, Y locations and the third column identifies 
the GPS time.  If no GPS time was provided in the imported file, that column will not be 
included in the exported file.  VSP includes a blank line between each unique COG 
transect surveyed on the site.  The anomaly file exported from VSP contains four 
columns as labeled and is shown in the center of Table 4.  If a grid value is not associated 
with an X, Y coordinate in VSP, the Grid value column will be blank for that anomaly.  If 
no anomaly locations have an associated value, that column will not be exported.  The 
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last file shown in Table 4 is obtained by clicking the “File Data” button when the 
histogram dialog shown in Figure 47 is open.  This dialog is found by clicking the “Find 
Targets” button within the VSP dialogs shown in Figure 18 and Figure 28.  This file 
contains the X, Y location of the density grid centers, the density for each value shown on 
the histogram, and the number of windows used to derive the averaged density value.  
The number of windows indicates how many individual density estimates (i.e., transect 
grid densities) were averaged into that anomaly density value (see Section 3.2.2). 
 
Table 4.  Example of the COG file (left), the anomaly file (center), and the grid densities from the 
histogram dialog (right).  Each of these files is provided in ASCII format. 
 

VSP exported COG file VSP exported anomaly file VSP exported anomaly grid data file 
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543425.47 3810332.02 67944.6 0 543531 3810330 288.47 202.602 2 545422.14 3805507.29
543477.12 3810331.41 67946.6 1 545430.3 3810330.3 65.52 43.4406 2 545500.34 3805507.29
543545.98 3810333.1 67948.6 2 543588.5 3810330.8 126.93 0 1 545578.54 3805507.29
543623.68 3810332.12 67950.6 3 543598 3810330.8 57.83 0 2 545656.74 3805507.29
543688.31 3810331.74 67952.6 4 545353.5 3810330.8 187.65 102.544 2 545734.94 3805507.29
543753.7 3810330.25 67954.6 5 543590.5 3810331 82.60 156.454 1 545813.14 3805507.29

543837.39 3810332.92 67956.6 6 543685 3810331.3 66.30 80.7637 2 545891.34 3805507.29
543923.63 3810332.03 67958.6 7 543543.8 3810331.5 53.37 131.453 1 545969.54 3805507.29
544019.59 3810331.95 67960.6 8 543622.3 3810332 148.77 60.6845 2 546047.74 3805507.29
544123.79 3810332.85 67962.6 9 543688.8 3810332 69.05 3.36988 1 546125.94 3805507.29
544227.04 3810331.81 67964.6 10 543694.3 3810332 80.37 28.8424 2 546204.14 3805507.29
544332.54 3810331.23 67966.6 11 543696 3810332 88.87 64.6605 2 546282.34 3805507.29
544434.79 3810332.25 67968.6 12 543741.5 3810332 54.55 75.2976 1 546360.54 3805507.29
544546.7 3810331.92 67970.6 13 545456.8 3810332 50.66 75.7235 2 546438.74 3805507.29

544661.42 3810332.03 67972.6 14 543617 3810332.3 46.58 15.5402 1 546516.94 3805507.29
544777.96 3810332.13 67974.6 15 543732.8 3810332.5 58.44 85.9175 2 546595.14 3805507.29
544894.58 3810331.88 67976.6 16 543514 3810332.8 58.46 32.0518 1 546673.34 3805507.29
544999.14 3810332.04 67978.6 17 543719 3810333 127.30 49.9516 2 546751.54 3805507.29
545110.55 3810331.86 67980.6 18 543500.3 3810334.3 57.47 33.3487 1 546829.74 3805507.29
545232.15 3810332.18 67982.6 19 545665.5 3810252.3 69.80 49.5986 3 546907.94 3805507.29
545349.98 3810331.22 67984.6 20 543687.5 3810252.5 153.03 70.9009 2 546986.14 3805507.29
545437.88 3810331.04 67986.6 21 546339.5 3810252.8 51.59 66.1721 1 547064.34 3805507.29
545481.77 3810331.79 67988.6 22 544188.8 3810253.3 43.80 28.7683 2 547142.54 3805507.29

   23 545419.8 3810253.5 120.52 25.8045 1 547220.74 3805507.29
546439.79 3810251.52 68992.6 24 545635.3 3810253.5 81.48 32.8722 2 547298.94 3805507.29
546381.92 3810254.54 68994.6 25 545638.8 3810253.5 70.54 43.185 1 547377.14 3805507.29
546306.55 3810253.59 68996.6 26 546254.3 3810253.5 78.47 57.8358 2 547455.34 3805507.29
546220.09 3810253.93 68998.6 27 545410.5 3810253.8 60.96 32.3786 2 547533.54 3805507.29
546122.99 3810253.9 69000.6 28 546084.8 3810253.8 76.17 34.4028 2 542841.53 3805585.49
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Figure 47.  Example of histogram dialog that is opened when the “Find Targets” button is selected as 
shown in Figure 18 and Figure 28.  The “file data” button allows the transect grid density information to be 
exported from VSP. 
 
As explained previously, the anomaly density estimates from kriging analysis using the 
“Geostatistical mapping of anomaly density” dialog then can be exported to a file format 
that is compatible with the ESRI ArcGIS geographic information software system.  By 
selecting “Map > Map Layers > Export” from the main VSP screen, the options for 
exporting the current kriging estimates or the kriging variances are provided.  Main-
taining the filename extension of “ASC” will provide direct recognition of the export file 
within ArcGIS.  This export file format can be directly read into ArcGIS. 
 
VSP also provides an automatically generated report for the three analysis dialogs that 
summarizes the inputs used to create the map shown in VSP.  When “Flag Areas with 
Density > Critical Density” is selected on the “Locate and Mark UXO Target Areas 
Based on Elevated Transect Anomaly Density” dialog and the report button (highlighted 
in green in Figure 48) is selected, a report summarizing the primary inputs of the window 
diameter and critical density used to create the flagging map in the VSP project file are 
shown.  The report associated with “Geostatistical Mapping of Anomaly Density” dialog 
is different and will provide the information needed to create the displayed geostatistical 
maps such as those shown in Section 4.3.  
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Figure 48.  Example of report view in VSP.  These reports can be seen by clicking the “Apply” button on 
the VSP dialog and then clicking the report button (highlighted in green).  The graph view button 
(highlighted in red) provides an improved view of the VSP generated graphs.  For the “Locate and Mark 
UXO Target Areas Based on Elevated Transect Anomaly Density” dialog, the graph view presents the 
histogram of transect grid densities.  
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8. Conclusions 
 
The four sampling goal priorities during site characterization explained in this report are: 
 

1) Transect design to ensure that target areas of concern are identified with a 
prescribed confidence level. 

2) Flagging of potential target areas along the transects obtained at the site. 
3) Mapping of the estimated anomaly density at all locations across the site based on 

the transect data and the model of spatial variation derived from those data.  
4) Delineation of the target boundary from the anomaly density maps.   

 
These four sampling and analysis goals are attained within VSP using the dialogues 
found under “Sampling Goals > Find UXO Target Areas.”  The functionality within 
the VSP UXO modules will provide DoD and contractor users with a set of useful tools 
for transect design, target area identification and delineation, and anomaly density 
mapping and estimation.  However, many additional features and functions are planned 
and will be added to improve usability in VSP.   
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